
Owner Preferences - Introduction

The Owner Preferences feature enables you to customize your Preferences in the ICQ program.    You do not need to configure 
these preferences in order for most features to work.    However, as you get to know ICQ, you will find that customizing enhances 
your ease and enjoyment of the program.

Note: The options provided below apply to the Advanced Mode of the program. The Simple Mode includes only some of the 
options. 

Preferences

To access the Preferences:

Click on the ICQ button and select Preferences. The Owner Prefs For [User] dialog includes the following    settings icons:

· The Contact List option enables you to customize the appearance and settings of your Contact List.

· The Miscellaneous option enables you to predetermine general settings.

· The Status Mode option enables you to set general Availability-Status configurations.

· The Telephony/Data/Games option enables you to configure the external applications. This option applies to Advanced Mode 
only.

· The Connections option enables you to specify the ICQ server to which you are connected.

· The Events option enables you to specify parameters for the incoming file transfers, ICQ chats, URLs, and sound 
configurations.

· The Shortcut Bar option allows you to customize your shortcut bar enabling you to access features most commonly used by 
you as well as other applications. This option applies to Advanced Mode only.

· The Security & Privacy option enables you to set certain security and privacy preferences.

· The ICQ Email Address Import option enables you to configure your ICQ Email Address Import settings.

· The Phone Book option enables you to configure your phone authorization and phone call request settings. This option 
applies to Advanced Mode only.

· The ICQ Greeting Card option enables you to configure your incoming Greeting card settings. This option applies to 
Advanced Mode only.

· The Email option enables you to configure your Email and ICQmail settings as well as the ICQ Email Check preferences. For 
more information on configuring Email Preferences, see the ICQmail   –   Configuring Preferences   section. This option applies 
to Advanced Mode only.

· The Picture option enables you to configure your picture authorization settings. This option applies to Advanced Mode only.

· The ICQ Offline Users Reminder option enables you to configure notification of offline users and the sending of a reminder 
letter via email. This option applies to Advanced Mode only.

· The ICQphone option enables you to configure your ICQphone settings. This option applies to Advanced Mode only.

· The SMS Messages option enables you to configure your SMS settings.
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Contact List Settings - Introduction

To access your Contact List Settings:

1. Click on the ICQ button and select Preferences.

2. Click on the Contact List icon to access the following tabs.

· Select the Options tab to customize the settings of your Contact List.

· Select the Design tab to customize the appearance of your Contact List. 

· Select the Shortcuts tab to edit your keyboard shortcuts on your Contact List. Applies to Advanced Mode only. 

· Select the Colors tab to change the colors of your Contact List. Applies to Advanced Mode only. 

3. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Contact List Settings - Options Tab

Configuring the Options Tab

The Options tab enables you to customize the settings of your Contact List. 

To configure the options on your Contact List:

1. Click on the ICQ button and select Preferences.

2. Click on the Contact List icon and choose the Options tab.

3. Choose from the following options in the Options window.

· Check the Popup Contact List upon incoming event box to set your Contact List to automatically open (when it was 
minimized) upon receipt of an incoming event. 

· Check the ICQ Window, when open, always showing on your desktop box so that the ICQ Window, when open, is 
always showing on your desktop. This option applies to Advanced Mode only.

· Check the “Floating Users” always showing on desktop box if you wish floating users (which you designated by 
selecting a user on you Contact List, choosing "Floating" option) to always be showing on your desktop when ICQ is 
open. Alternatively, you may also click on the name from your Contact List and drag it onto your desktop. This option 
applies to Advanced Mode only.

· Check the Move the last user that sent an event to the top of the Contact List box if you want the sender of the last 
event to appear at the top of your Contact List or group. This option applies to Advanced Mode only.

· Choose from the following options in the Auto Hide window.

· Check the Auto Hide Delay box and select a number of seconds to set ICQ to automatically remove itself from your 
screen after a certain interval when not in use. This option applies to Advanced Mode only.

· Check the Auto hide as Windows taskbar box if you checked the Auto Hide Delay box and you want the Window to 
disappear from your desktop when you move your cursor to the desktop or application that you are working on. The 
Window reappears when you move your cursor to the previous location of your Contact List. This option applies to 
Advanced Mode only.

· Choose from the following options in the Alerts window.

· Check the Global online alert by: box to receive an online global alert when a user comes online. Then check the 
Blink box to receive a flashing user name alert and/or the Sound box to receive a sound alert.

· If you checked the Global online alert by: box, check the Alert when returning from “NA/Away” box to receive 
an online alert from users that return to Online/Available mode, from N/A mode and Away mode.

· Check the Blink in tray only when minimized box to set ICQ to notify you of incoming events by a flashing icon in your 
desktop tray only when your Contact List is minimized. This option applies to Advanced Mode only.

4. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Contact List Settings - Design Tab 

Configuring the Design Tab

The Design tab enables you to customize the appearance of your Contact List. 

To configure your Contact List design:

1. Click on the ICQ button and select Preferences.

2. Click on the Contact List icon and choose the Design tab.

3. Choose from the following options in the Design window.

· Check the Show top ICQ buttons box to show the User/Groups and the All/Online buttons at the top of your ICQ 
Window. This option applies to Advanced Mode only.

· Check the Show bottom ICQ buttons box to show the Add/Invite Users, Services and My ICQ buttons and the bottom 
of your ICQ Window. This option applies to Advanced Mode only.

· Check the Show Contact List buttons box to show the buttons that appear at the bottom of your Contact List. These 
include the Help Cards, the To Simple Mode, and the Chat With A Friend buttons. 

· Check the Show shortcut bar (ICQ Quick) box to enable the Shortcut Bar feature on your ICQ Window. This option 
applies to Advanced Mode only.

· Check the Auto hide shortcut bar (ICQ Quick) box to hide the shortcut bar when your cursor is not positioned on the 
right of your ICQ Window. This option applies to Advanced Mode only.

· Check the Show user ToolTip box to enable the User ToolTips feature on your Contact List. 

· Check the Sort Contact List by: box and then select either the Name radio ¤ button or the Status radio ¤ button to 
view the names on your Contact List either alphabetically by name or according to their Availability status.

4. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Contact List Settings - Shortcuts Tab

Configuring the Shortcuts Tab

The Shortcuts tab enables you to edit your keyboard shortcuts on your Contact List. 

Note: This option applies to Advanced Mode only.

To configure your Contact List shortcuts:

1. Click on the ICQ button and select Preferences.

2. Click on the Contact List icon and choose the Shortcuts tab.

3. Check the Activate ICQ Keyboard Shortcuts box (set by default) to enable the following options.

· Choose the feature you wish to edit from the ICQ Feature: field.

· The current keyboard shortcut to the feature you chose is displayed in the Current Assign Shortcut: field.

· Type in the new keyboard command in the Edit Current Shortcut: field.

4. Click on the Reset button to reset the default shortcut for the chosen feature.

5. Click on the Reset All button to reset the default shortcuts for all the features.

6. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Contact List Settings - Colors Tab 

Configuring the Colors Tab

The Colors tab enables you to change the colors of your Contact List. 

Note: This option applies to Advanced Mode only.

To configure your Contact List colors:

1. Click on the ICQ button and select Preferences.

2. Click on the Contact List icon and choose the Colors tab.

3. Click on a Color field in the Contact List Colors window and choose a color for that text of that option.

4. Check the Background Color box in the Contact List Background Color window and click on the Color field to choose a 
color to appear in the background of your Contact List.

5. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Miscellaneous - Configuring Settings 

Configuring Miscellaneous Settings 

The Miscellaneous option enables you to predetermine general settings, such as showing ICQ announcements, automatically 
receiving external applications, setting multi-language support, and more. 

To configure settings of incoming events:

1. Click on the ICQ button and select Preferences.

2. Click on the Miscellaneous icon. 

3. Choose from the following options.

· Check the Multi language support box to be able to write messages in other languages (as long as the language 
program exists in your computer).

· Check the Show ICQ announcements box to enable the ICQ Announcements to be displayed upon start-up of the 
program.

· Check the Access menus by left button box to be able to access the user menus for each user on your Contact List by 
using the left mouse button. (This is the default.)

· Check the Activate "ICQ Send To User" shell extension box to be able to open a list of your contacts from any file on 
your desktop. This option applies to Advanced Mode only. This option applies to Advanced Mode only.

4. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Status Mode – Configuring Settings 

The Status Mode tab enables you to predetermine the amount of time to pass before ICQ automatically switches you into either 
“Away” status mode or “N/A” status mode.    When you step away from your computer, ICQ will automatically switch you into 
“Away” status mode or “N/A” status mode after the designated time you have predetermined.    You may also determine whether 
or not your desktop tray will display incoming messages regardless of your availability status.

Note: This option applies to Advanced Mode only.

To configure your Availability-Status Mode Settings:

1. Click on the ICQ button and select Preferences.

2. Click on the Status Mode icon.

3. Choose from the following options.

· Check the Set “Away” status after – minutes of not using the computer box and enter the amount of time in the 
blank field to determine how long before ICQ switches into “Away” status when you step away from your computer.

· Check the Set “N/A” status after – minutes of “Away” box and enter the amount of time in the blank field to 
determine how long before ICQ switches into “N/A” status when you have been in “Away” status for designated amount 
of time.

· Check the Show messages in tray in all status modes.    Incoming even icon will flash in your desktop tray 
regardless of your status mode box to have all incoming messages displayed by a flashing icon in your desktop tray 
regardless of your Availability status.

· Check the Disable “Online Alert” messages in “Away”, “DND”, “N/A”, and “Occupied” box to have online alert 
messages disabled.

4. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Telephony/Data/Games - Configuring Settings

ICQ is perfect for launching Internet Telephony/Voice Chat/Games applications, or any other external application utilizing direct 
user connection. In order to use external applications you must configure them in your Owner Preferences. See Internet 
Telephony/Game Request (External Application)  —  Launching  .

Note: This option applies to Advanced Mode only.

To configure the application into your Owner Preferences:

1. Click on the ICQ button and select Preferences.

2. Click on the Telephony/Data/Games icon.

3. Choose from the following options.

· Click on the New External button and choose a group from the pull-down menu next to the Group field. Enter a new 
external application in the Define New External Application dialog. Click on the Browse button to open the Open 
dialog and enter the relevant directory where you saved the application. Select the external application and click on the 
Open button. 

· Select an application under the heading Registered External Applications and click on the Edit button to configure an 
application that you have installed, but that ICQ does not yet recognize. In most cases, a Define New External 
Application dialog is displayed. Click on the Browse button to open the Open dialog where you should find and enter 
the relevant directory where you saved the application. Select the external application and click on the Open button. 

· Click on the Remove button to take out an application from the list.

4. Click on the OK button to return to the Owner Prefs For: [User] dialog, and click on the OK button again to set your 
changes. When you view the list of applications in the Externals tab, a unique icon appears next to the installed application.
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Connections Settings – Introduction 

To access your Connections Settings:

1. Click on the ICQ button and select Preferences.

2. Click on the Connections icon to access the following tabs.

· Select the General tab to change the Internet connection type that you entered upon registration, as well as several ICQ 
default settings.

· Select the Server tab to configure your ICQ server host and port.

· Select the Firewall tab to configure Proxy server settings if you are a behind a firewall.

· Select the User tab to change the incoming ports for communication with users that are behind a Firewall.

3. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Connections Settings - General Tab

Configuring the General Tab

The General tab enables you to change the Internet connection type that you entered upon registration, as well as several ICQ 
default settings. 

To specify your Internet connection type:

1. Click on the ICQ button and select Preferences.

2. Click on the Connections icon and choose the General tab.

3. Choose from the following options.

· Select the Modem (dial-up connection) radio ¤ button if you are connected through a modem or any other dialup 
device.

· Select the Permanent (LAN, Cable Modem, etc.) radio ¤ button if you are connected through a LAN. 

· Check the Launch ICQ on startup box to launch the NetDetect Agent when you start your computer, which will 
automatically launch ICQ when you connect to the Internet.

· Check the Launch default Web browser when connection is detected box to automatically launch your Web browser 
upon connection to ICQ or to the Internet.

· Check the Automatically activate sleep mode upon disconnection box to put the NetDetect Agent in your desktop so 
that ICQ is launched upon connection to the Internet.    (If you’ve disconnected from the Internet and closed ICQ, once 
you re-connect to the Internet again, this option will launch your ICQ.)

· Click on the Edit Launch List button if you wish to launch other applications upon connection to the Internet. 

Click on the Add button to display the NetDetect Launch Application dialog.

Enter the name of the application in the Enter Application Name field.

Enter the executable file (*.exe) in the Application Executable Path field, or click on the Browse button to locate the 
file.

Enter the command line in the Command Line Parameters field.

Enter the directory path in the StartUp Path field, or click on the Browse button that specifies the folder that contains 
the original item or some related files.    Sometimes, folders need to use files from other locations.    You may need to 
specify the folder where these files are located so that ICQ can locate the program.

4. Choose from the following options if you have problems communicating with other users.

· Click the Always use internal IP radio ¤ button to use your internal IP number.

· Click the ICQ will determine the IP automatically radio ¤ button to allow ICQ to choose whether to use your real IP or 
internal IP to establish the best connection.

· Click the Always use external IP radio ¤ button to use your real (external) IP number.

5. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Connections Settings - Server Tab

Configuring the Server Tab

The Servers tab enables you to change the configurations of your ICQ server host and port.

To change the configurations of your ICQ server:

1. Click on the ICQ button and select Preferences.

2. Click on the Connections icon and choose the Server tab.

3. Enter the host in the Host field.

4. Enter the port in the Port field.    Or, choose from the following options.

· Click on the Auto Configure button to change the configurations automatically.

· Click on the Reset button to reset the default settings.

5. Choose from the following options.

· Click on the Not using Firewall radio ¤ button if you are not using a firewall.

· Click on the Using Firewall radio ¤ button if you are using a firewall.

Click on the Not using proxy radio ¤ button if you are not using a proxy.

Click on the Using Proxy radio ¤ button if you are using a proxy and then use the pull-down menu to choose the proxy 
you are using.

6. Check the Keep connection alive box to ensure you do not lose connection to the server.

7. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Connections Settings - Firewall Tab

Configuring the Firewall Tab

The Firewall tab allows you to change your Proxy server settings if you are behind a Firewall.    You may define more than one 
Proxy.

To define your Proxy:

1. Click on the ICQ button and select Preferences.

2. Click on the Connections icon and choose the Firewall tab.

3. Enter the host in the Host field.

4. Enter the port in the Port field.

5. Check the Authentication box to have ICQ request your user authentication each time you startup.

· Enter your username in the Username field.

· Enter your password in the Password field.

6. Choose from the following options.

· Check the External proxy IP: box and enter your proxy IP number in the blank field.

· Check the Use proxy to resolve hostnames box to have the proxy define your hostnames.

7. Click on Apply to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Connections Settings - User Tab

Configuring the User Tab

The User tab enables you to change the incoming ports for communication with users that are behind a Firewall.

To change the incoming ports:

1. Click on the ICQ button and select Preferences.

2. Click on the Connections icon and choose the User tab

3. Choose from the following options:

· Click the Use server proxy settings (recommended) radio ¤ button to use the proxy settings recommended. You may 
view these settings in the Server tab.

· Click the Not Using Proxy radio ¤ button to change the incoming ports if you are not using a proxy.

Click on the Use dynamically allocated port numbers (default) radio ¤ button to use the port numbers allocated by 
ICQ.

Click on the Use the following TCP listen port for incoming event radio ¤ button to enter incoming ports.

Enter the TCP listen ports in the From: __ To: __ fields.

· Click the Using Proxy radio ¤ button to determine the type of proxy you are using.

Use the pull-down menu to choose the proxy from the Select from the list below type of proxy field.

4. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Events Settings - Introduction

To access your Contact List Settings:

1. Click on the ICQ button and select Preferences.

2. Click on the Events icon to access the following tabs.

· Select the General tab to specify the parameters regarding sending or receiving events.

· Select the Chat tab to configure your settings for ICQ Chats requests. This option applies to Advanced Mode only.

· Select the Web Page (URL) tab to configure the settings for Web Page Addresses (URLs). This option applies to 
Advanced Mode only.

· Select the File Transfer tab to specify parameters for incoming file transfers. This option applies to Advanced Mode only.

· Select the Internet Externals tab to specify the parameters for Internet Externals requests. This option applies to 
Advanced Mode only.

· Select the Sounds tab to configure your sound events. This option applies to Advanced Mode only.

3. Click on the Apply button to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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Events Settings - General Tab

Configuring the General Tab

The General tab enables you to specify parameters regarding sending or receiving events.

To configure additional options to apply to all events:

1. Click on the ICQ button and select Preferences.

2. Click on the Events icon and choose the General tab.

3. Choose from the following options.

· Check the Pop up response dialog on your desktop without having to double-click on the incoming event icon 
box if you want a response dialog to automatically display upon receipt of the event.

· Check the Set ICQ to automatically select a sender’s name on your Contact List upon receipt of the selected 
event from him/her box to automatically have a sender's name highlighted on your Contact List upon receipt of the 
event from that user.

· Check the Automatically send messages through server if direct connection fails box to automatically send the 
event through the ICQ server.

· Check the Configure ICQ to play a sound upon receipt of an event box to have ICQ give you a sound alert upon 
receipt of an event.

· Check the Do not log event history box to disable the History of Events feature that automatically saves all incoming 
events

4. Click Apply to save your changes or click on the Cancel button to exit the dialog without saving your changes.
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Events Settings - Chat Tab

Configuring the Chat Tab

The Chat tab enables you to configure your settings for ICQ Chats requests.

Note: This option applies to Advanced Mode only.

To configure incoming ICQ chat requests:

1. Click on the ICQ button and select Preferences.

2. Click on the Events icon and choose the Chat tab.

3. Choose from the following options.

· Select the Display incoming Chat Request dialog upon receipt of a Chat Request radio ¤ button to automatically 
display the Incoming Chat Request dialog upon receipt of a chat request. From this dialog, you may choose to accept 
or decline the chat request.

· Select the Automatically receive all incoming Chat Requests radio ¤ button to have all incoming chat requests 
automatically accepted. Then choose from the following options.

Check the Minimize the intermediary dialogs between requesting a Chat and opening the Chat screen box or the 
Let other users join your Chat session without your authorization box.

· Select the Automatically refuse all Chat Requests radio ¤ button to have all chat requests automatically refused.

4. Click Apply to save your changes, or click on the Cancel button to exit the dialog without saving your changes.

Note: Accepting a chat request will enable the sender and any other user who joins the chat session to view your IP address.
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Events Settings – Web Page (URL) Tab 

Configuring the Web Page (URL) Tab

The URL tab enables you to configure the settings for Web Page Addresses (URLs).

Note: This option applies to Advanced Mode only.

To configure incoming Web Page Addresses:

1. Click on the ICQ button and select Preferences.

2. Click on the Events icon and choose the Web Page (URL) tab.

3. Choose from the following options.

· Select the Show URL Response Dialog when receiving a Web page address radio ¤ button to display the Incoming 
Event dialog upon receipt of a URL. You may then save the Web Page Address to a bookmark and open the Web page 
in your browser.

· Select the Automatically add URL to Bookmarks list radio ¤ button to automatically add the URL to your list of 
bookmarks if your browser is Internet Explorer. 

· Select the Automatically refuse all incoming Web page address messages radio ¤ button to have all incoming URLs 
automatically declined.

· Check the Automatically open all incoming Web page addresses in your Web browser box to have all incoming 
Web page addresses in your Web browser automatically displayed on your desktop. Then choose from the following 
options.

Select Open in new browser window to open a separate window to view an incoming URL when your browser is 
already open to another Web site.

Select Open in current browser window to open an incoming URL in your open browser window, replacing the Web 
site you were already viewing.

4. Click Apply to save your changes, or click on the Cancel button to exit the dialog without saving your changes.

This Help File including Help Cards is provided as a convenience only (*See Welcome to ICQ Version 2000b) and is subject to the 
provisions of the ICQ Terms of Service.

* Access the Main Help File by clicking the ICQ button, selecting Help and then Help Index.

Copyright © 1996-2000 ICQ Inc. All Rights Reserved.



Events Settings - File Tab 

Configuring the File Tab

The File Transfer tab enables you to specify parameters for incoming file transfers.

Note: This option applies to Advanced Mode only.

To configure your incoming file transfers:

1. Click on the ICQ button and select Preferences.

2. Click on the Events icon and choose the File Transfer tab.

3. Choose from the following options.

· Select the Show File Request Response Dialog when receiving an incoming file radio ¤ button if you want to 
receive a File Request dialog when you receive an incoming file. You may then accept or refuse the request.

· Select the Accept all incoming File Requests automatically radio ¤ button to accept all incoming file requests 
automatically.
You may also check the Minimize the File Transfer dialog when receiving a File Transfer box.

· Select the Automatically refuse all incoming file requests radio ¤ button to have all incoming file requests 
automatically declined. The user who sent you the file transfer request will receive a dialog stating that you have 
declined to accept the file.

· Check the Automatically refuse File Transfer requests sent by users not on my Contact List box to have all file 
transfer requests sent by users who are not on your Contact List automatically declined.

· Check the Overwrite received files with incoming files by the same name box to overwrite previously received files 
by the same name.

· Click on the  button to choose the file path in which you want to save the incoming files. You may choose to leave the 
default file path C:\Program Files\ICQ\Received Files.

· Check the Save under user name folder box to save the file under the name of the user that sent you the folder. 

4. Click Apply to save your changes, or click on the Cancel button to exit the dialog without saving your changes.

Note: Accepting a file transfer will enable the sender to view your IP address.

Caution! Some files may be harmful. Before receiving any files from any user, and even if the ICQ# from which the file transfer 
notice is sent looks familiar to you, it is strongly recommended that you verify that the person sending you these files is indeed 
the person you think he is. For example ask him/her for some kind of information known only to the both of you. Please make 
sure not to receive files from users you do not trust, from users you are not sure they are who they say they are or whenever you 
are not sure you want to receive the files. 

This Help File including Help Cards is provided as a convenience only (*See Welcome to ICQ Version 2000b) and is subject to the 
provisions of the ICQ Terms of Service.
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Events Settings – Internet Externals Tab

Configuring the Internet Externals Tab

The IP & Games tab enables you to specify the parameters for Internet Telephony/Games/Chats requests.

Note: This option applies to Advanced Mode only.

To configure your incoming Internet Telephony/Games/Chat requests:

1. Click on the ICQ button and select Preferences.

2. Click on the Events icon and choose the Internet Externals tab.

3. Choose from the following options.

· Select the Show Internet Telephony/Games/Chat Request Response Dialog upon receipt of an event radio ¤ 
button to display the dialog upon receipt of an event so you may then choose to accept or refuse the incoming event 
request for launching an external application.

· Select the Automatically accept all incoming requests to launch Internet Telephony/ Games/Chat external 
applications radio ¤ button to automatically accept all incoming requests to launch external applications.

· Click the Automatically refuse all incoming requests to launch external applications radio ¤ button to automatically 
decline all incoming requests to launch external applications.

4. Click Apply to save your changes, or click on the Cancel button to exit the dialog without saving your changes.

Note: Accepting an Internet Telephony/Games/Chat request will enable the sender, and may enable others who join this session, 
to view your IP address. 
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Events Settings - Sounds Tab 

Configuring the Sounds Tab

The Sound Configuration tab enables you to configure your sound events.

Note: This option applies to Advanced Mode only.

To configure the your sound events:

1. Click on the ICQ button and select Preferences.

2. Click on the Events icon and choose the Sounds tab.

3. Select an event under the heading Events and choose from the following options.

· Click on the Select button to select a sound for that event from another file. 

· Click on the Disable button to disable any sound for that incoming event. 

· Click on the Preview button to hear the default sound or the sound you selected.

4. Select a scheme from the Sound Schemes pull-down menu and choose from the following options.

· Select ICQ Defaults to restore the ready made sound scheme that comes with your program.

· Configure a sound for each event and click on the Save As button to save it as another sound scheme that will appear 
in the Sound Schemes pull-down menu.

· Click on the Export button to save a sound scheme in another location.    This option allows you to send it to other ICQ 
users. 

· Click on the Import button to configure a sound scheme from another directory. 

· Select a scheme from the pull-down menu under the heading Sound Schemes and then click on the Delete button to 
delete that scheme from the pull-down menu of options. 

5. Click Apply to save your changes, or click on the Cancel button to exit the dialog without saving your changes.
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ICQ Shortcut Bar (ICQ Quick) - Configuring Settings 

ICQ Quick provides you with a convenient and easy way to access ICQ functions. ICQ comes with a default shortcut bar on the 
right side pane of your ICQ Window. You may add the shortcuts available to you by ICQ, add short cuts from any other 
applications, remove them when necessary and even position them in a different order. See ICQ Quick Shortcut Bar  —  
Customizing.

Note: This option applies to Advanced Mode only.

To customize your ICQ Quick Shortcut Bar:

1. Click on the ICQ button and select Preferences.

2. Click on the Shortcut Bar icon.

3. Choose from the following options.

· Highlight the icon that you wish to add to your shortcut list and click on the Add button to add them to your shortcut bar.

· Click on the Add File button if you wish to add a shortcut icon for another application and choose the file path. You may 
also import shortcuts unto your shortcut bar by simply dragging and dropping them into your shortcut bar.

· Highlight the shortcut that you wish to remove from the box on the right side of the dialog and click on the Remove 
button.

· Select the shortcut and click on the Up button if you wish to move the icon up on the list.

· Select the shortcut and click on the Down button if you wish to move the icon down on the list.

· Click on the Restore ICQ Defaults button if you wish to have only the ICQ default shortcuts on your shortcut bar.

4. Click Apply to save your changes or click on the Cancel button to exit the dialog without saving your changes.

This Help File including Help Cards is provided as a convenience only (*See Welcome to ICQ Version 2000b) and is subject to the 
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Security and Privacy - Introduction

ICQ offers various Security and Privacy features, including options that were designed to assist you in taking part in determining 
the level of privacy with which you feel most comfortable. The ICQ features and options described in this Help File, including 
security and privacy features, may not operate according to the description provided in this Help File or may not operate at all.

The various ICQ software versions may contain different privacy and security features made to enable you to maintain your 
privacy while still enjoying ICQ. The privacy and security issues described here for ICQ 2000b, which should be suitable for 
Windows 95, Windows 98, Windows 2000 and Windows NT, may not apply to other versions of the ICQ software such as 99a, 
99b, Windows CE, the Macintosh versions or the Java versions of ICQ. Also note that the security and privacy issues described in 
this section refers to both the Simple and Advanced Mode options of ICQ 2000b unless indicated otherwise. You are, therefore, 
advised to carefully study the relevant and applicable security and privacy features before using each such different version.

To configure your security and privacy settings:

1. Click on the ICQ button in your ICQ Window. 

2. Select Security & Privacy. You may also access the Security & Privacy settings from Preferences. 

3. Choose from the following tabs.

· Select the General tab to determine if users need your authorization to add you to their Contact Lists, to set your Security 
Level and determine whether to enable others to view your online/offline status from the Web.

· Select the Password tab to change your password.

· Select the Direct Connection tab to configure your peer-to-peer communication preferences.

· Select the Ignore tab to set ICQ to ignore messages, URLs, chat or authorization requests, and other events sent to 
your ICQ# from an ICQ# on your Ignore List. You may also use this tab to choose whether to accept messages only 
from users on your Contact List and/or to ignore WWPager, EmailExpress messages, and multi-recipient messages 
and/or not to allow Direct Connection communication with previous versions of ICQ which do not fully support the Direct 
Connection feature. This tab also enables you to control some of the spam and junk mail you may receive from time to 
time. When you place a user on your Ignore List, you will not receive events sent by this user to your ICQ#. The user will 
not be aware that the events he or she is sending are not displayed to you.

· Select the Invisible tab to determine if a user that has you on his/her Contact List can see your online status.    This tab 
enables you to appear offline on such a user’s Contact List even if you are online. This option applies to Advanced 
Mode only. 

· Select the Visible tab to determine if your status will be visible on a user’s Contact List, even if you are in Privacy 
(Invisible) status.    See Availability-Status Modes. This option applies to Advanced Mode only. 

· Select the Words List tab to filter your present choice of words and URLs from incoming ICQ events, search results 
information pertaining to queries you made on the ICQ Global Directory for information about users and information on 
random users available through the Chat With A Friend feature.

4. Click on the Save button to save your changes, or click Cancel to exit the dialog without saving your changes.

See also Availability-Status Modes 

IMPORTANT NOTICE

Please note that the ICQ service is not for use by children under 13 years of age.    If it comes to 
ICQ's attention through reliable means that a registered user is a child under 13 years of age, 
ICQ will cancel that user's account.

Also please note that the ICQ service and software, as with most Internet applications, is 
vulnerable to various security issues and hence should be considered unsecured. By using the 
ICQ service and software and the Internet in general, you may be subject to various risks, 
including among others: 

· Exposure to objectionable material and/or parties, including without limitation, 
contaminated files. 

· Unauthorized invasion of your privacy during, or as a result of, your use or another's 
use of the system. 

· Spoofing, eavesdropping, sniffing, spamming, breaking passwords, harassment, fraud, 



forgery, "imposturing", electronic trespassing, tampering, hacking, nuking, system 
contamination including without limitation use of viruses, worms and Trojan horses 
causing unauthorized, damaging or harmful access and/or retrieval of information and 
data on your computer and other forms of activity that may even be considered 
unlawful.

· Unauthorized exposure of information and material you listed or sent, on or through the 
ICQ system to other users, the general public or any other specific entities for which the 
information and material was not intended by you. 

If you do not wish to be subjected to these risks, you are advised not to use the ICQ service and 
software. Furthermore, please do not use the ICQ service and software for "Mission Critical" or 
"Content Sensitive" applications and purposes. For the purpose of this section "Mission Critical" 
applications and purposes shall mean applications and use that may result in damage; "Content 
Sensitive" shall mean any information or data you do not wish to be freely accessible and 
generally available to Internet users.

Please note that in each and every Internet application, the IP address of the sender is an 
integral part of the TCP/IP standard protocol of the Internet, and can be extracted by any party to 
the communication session using certain software and/or hardware.    Also note that the IP 
privacy feature, designed to allow an ICQ user to reduce the exposure of his/her IP address on 
ICQ, is provided to you as a convenience only and does not guarantee a complete non-exposure 
of your IP address. 

For the ICQ software's terms of service please review the ICQ License Agreement, the Privacy 
Policy, the Acceptable Use Policy, Usage Notices, Tools Notices and any other terms of service 
document available on or through http://www.icq.com/legal. Always check for the latest terms of 
service available on or through http://www.icq.com/legal.

European Union ICQ users understand and consent to the processing of personal information in 
the United States.

This Help File including Help Cards is provided as a convenience only (*See Welcome to ICQ Version 2000b) and is subject to the 
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Security and Privacy - General Tab

Configuring the General Tab

The General tab allows you to determine if users need your authorization to add you to their Contact Lists, to set your Web Aware 
authorization, and to determine your security level.

To access the General tab in order to configure the ICQ security settings:

1. Click on the ICQ button and select Security & Privacy to display the Security (Ignore/Spam, harassment control) For: 
[User] dialog. Or access the tab from Preferences.

2. Click on the General tab. 

3. Choose from the following options.

· Authorization Mode   –   Changing   This option allows you to determine whether or not users should request your 
permission to add you to their Contact Lists, thus allowing them to detect your status.    You set your Authorization mode 
during the ICQ registration process or you may change it at any time. See Authorization Mode.

· Security Level   –   Selecting      This option allows you to choose from three settings to determine your ICQ program’s 
security level, regarding when you are required to enter your password.    If you are the only one with access to your 
computer, you may select the low security level so that you don’t need to enter your password every time you log on to 
ICQ and in other operations.    Or, you may select the medium security level so that you are required to enter your 
password only for certain ICQ activities. (for example, to change your User Details).    If others have access to your 
computer, you may choose high security level so that you are required to enter your password every time you log on to 
ICQ and for other ICQ activities once ICQ is open.

· Web Aware   –   Activating      The Web Aware security feature allows you to determine whether others can see your 
online/offline status on the World Wide Web.    When you activate this feature other Internet users will able to see your 
online or offline status. 

4. Click on the More About ICQ Security button to be led, via your browser, to ICQ's Online Security and Privacy Center.

5. Click on the Save button to save your changes, or click on the Cancel button to exit the dialog without saving your changes. 
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Security and Privacy - Ignore Tab

Configuring the Ignore tab

In the Ignore tab you may set ICQ to ignore messages, URLs, chat or authorization requests, and other ICQ events sent to your 
ICQ# from an ICQ# on your Ignore List. You may also choose whether to accept messages only from users on your Contact List 
and/or to ignore WWPager, EmailExpress messages, and multi-recipient messages and/or not to allow Direct Connection 
communication with previous versions of ICQ. When you place a user on your Ignore List, you will not receive events sent by this 
user. The user will not be aware that the events he/she is sending are not displayed to you.

The Ignore List

The Ignore List is designed to assist in avoiding and reducing potential exposure to harassment via ICQ from others including 
other ICQ users. ICQ should automatically refrain from displaying any event sent from a specific ICQ# on your Ignore List to your 
ICQ#. Once a user is on your Ignore List, any attempt he/she makes to contact you should be completely ignored without you 
being aware of it and without providing the sender with any indication that he/she is on your Ignore List.

Note: The ignore options do not apply to ICQ SMS messages.

To limit the type of events you receive:

1. Click on the ICQ button and select Security & Privacy to display the Security (Ignore/Spam, harassment control) For: 
[User] dialog.

2. Click on the Ignore tab.

3. Choose from the following options.

· Check the Do not accept WWPager messages box to set the system to ignore WWPager messages.

· Check the Do not accept any EmailExpress messages box to set the system to ignore EmailExpress messages.

4. Click on the Save button to save your changes.

To limit the users from whom you receive messages:

1. In the Ignore tab, choose from the following options. 

· Check the Accept messages only from users on my Contact List box to set the system to ignore events from users 
not on your Contact List.

A Padlock icon will appear on the System Notice button in your ICQ Window when you check this option, 
reminding you that all events from users who are not on your Contact List will be ignored.

· Check the Do Not Accept Multi-Recipient Messages from box to set the system to ignore events that were sent to 
more than one recipient using the Multi-Recipient function.

After checking this box, click on the arrow next to the corresponding field and select Users Not On My Contact 
List to ignore Multi-Recipient Messages only from Users not on your Contact List, or select All Users to ignore all 
Multi-Recipient Messages.

· Check the Do not allow Direct Connection with previous ICQ Software versions if you do not wish to receive events 
from ICQ users with earlier versions of ICQ.

2. Click on the Save button to save your changes.

To add a specific user to your Ignore List:

Tip:    The easiest way to add a user who appears on your Contact List on to your Ignore List is to click and drag the user's name 
from your Contact List into the Ignore List in the Ignore tab.

Note: Moving a user to your Ignore List will automatically remove him/her from your Contact List.

1. In the Ignore tab, click on the Add To Ignore List button to display a Search for users to add to your Ignore List dialog.

2. Choose one of the tabs—Email, Details, ICQ# or Interests and enter the corresponding details about the user whose events 
you want to ignore.

3. Click on the Search button.

4. When the search is finished, double-click the user to be added to the Ignore List. Events from this user will be ignored.    



Alternatively, right-click on the name of the user you want to add to your Ignore List and select Move To Ignore List.

5. Click on the OK button to return to the Ignore List tab. 

6. Click on the Import button to add a user or a group of users to your Ignore List from another file on your computer.

7. Click on the Export button to save your Ignore List in a separate file.

8. Click on the Save button to save your changes.

To remove a user from the Ignore List:

1. In the Ignore tab, select the user on the Ignore List and click on the Remove From Ignore List button. 

2. Click on the Save button to save your changes, or click Cancel to exit the dialog without saving your changes.
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Security and Privacy - Visible Tab

Configuring the Visible Tab

The Visible feature allows you to select users who will be able to see your online status even when you are in the Privacy 
(Invisible) Availability-Status mode. 

Note: This option applies to Advanced Mode only.

Note: If the Web Aware option (in the General tab) is checked, anyone, including the the users on your Visible List, will still be able 
to see your offline status on the Web.

To place an ICQ user on your Visible List:

1. Click on the ICQ button and select Security & Privacy to display the Security (Ignore/Spam, harassment control) For: 
[User] dialog.

2. Click on the Visible tab.

Tip:    The easiest way to add a user who appears on your Contact List on to your Visible List is to click and drag the user's 
name from your Contact List into the Visible List in the Visible tab.

3. Click on the Add To Visible List button to display a Search for users to add to your Visible List dialog.

4. Choose one of the tabs - Email, Details, ICQ#    or Interests and enter the corresponding details about the user for whom 
you want to override your Privacy (Invisible) Availability-Status mode. 

5. Click on the Search button.

6. When the search is finished, double-click on the name of the user you want to add to your Visible List.    Alternatively, right-
click on the name of the user you want to add to your Visible List and select Add to visible list to display the Add To Visible 
List dialog.

Click on the OK button to add the user to your Visible List, or exit the dialog without adding the user to the list. 

7. Click on the New Search button to carry out another search for an additional ICQ user to place on your Visible List, or click 
on the X to return to the Visible tab.

8. Click on the Save button to save your changes.

To remove a user from the Visible List:

1. In the Visible tab, select the name of the user you would like to remove from your Visible List and click on the Remove From 
Visible List button.    Alternatively, right-click on the name of the user you would like to remove and select Remove From 
Visible List.

2. Click on the Save button to save your changes, or click Cancel to exit the dialog without saving your changes.
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Security and Privacy - Invisible Tab

Configuring the Invisible tab

When you place an ICQ user on your Invisible List, the ICQ user will not be able to see your online status, but messages from this 
ICQ user will still be delivered to you online. The user will see your status as offline even if you are online and in one of the 
Availability-Status modes.

Note: This option applies to Advanced Mode only.

Please note: During the period your ICQ number's Web Aware feature is activated, and your ICQ software is connected to the 
ICQ servers, the Web status indicators pertaining to your ICQ number will indicate that your ICQ number is in online, even if you 
activated an Invisible (Privacy) mode with respect to certain users. Also please note that even if you chose to activate an Invisible 
(Privacy) mode with respect to certain users, other users may be aware of your ICQ number online status during the time your ICQ 
software is connected to any of the ICQ ActiveLists.

To place an ICQ user on your Invisible List:

1. Click on the ICQ button and select Security & Privacy to display the Security (Ignore/Spam, harassment control) For: 
[User] dialog.

2. Click on the Invisible tab.

Tip:    The easiest way to add a user who appears on your Contact List on to your Invisible List is to click and drag the user's 
name from your Contact List into the Invisible List on the Invisible tab.

3. Click on the Add To Invisible List button to display a Search for users to add to your Invisible List dialog.

4. Choose one of the tabs - Email, Details, ICQ# or Interests and enter the corresponding details about the user for whom you 
want to override your Privacy (Invisible) Availability-Status mode. 

5. Click on the Search button.

6. Double-click on the name of the user you would like to add to your Invisible List.    Alternatively, right-click on the name of the 
user you want to add to your Visible List and select Add to invisible list.

7. The Add To Invisible List dialog is displayed.    Click on the OK button to add the user to your Invisible List.

8. Click on the New Search button when you want to carry out a new search for an additional ICQ user to place on your 
Invisible List, or click on the X to return to the Invisible tab.

9. Click on the Save button to save your changes.

Note:    You also have the option to place a user in your Invisible List from the Alert/Accept Modes feature. 

To remove a user from your Invisible List:

1. In the Invisible tab, select the name of the user you would like to remove from your Invisible List and click on the Remove 
From Invisible List button.    Alternatively, right-click on the user you would like to remove and select Remove from 
Invisible List. 

2. Click on the Save button to save your settings, or click Cancel to exit the dialog without saving your changes.
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Security and Privacy - Words List Tab

Configuring the Words List tab

The Words List feature allows you to filter your present choice of words and URLs ("Filtered Words") from incoming ICQ events, 
search results information pertaining to queries you made on the ICQ Global Directory for information about users and information 
on random users available through the Random Chat feature (collectively "Incoming ICQ Info").

You may choose among the following filtering options: all Incoming ICQ Info containing any of the Filtered Words will not be 
displayed in its entirety; or, all Incoming ICQ Info containing Filtered Words will be displayed with a pre-defined character (such as 
an asterisk (*) for example, replacing the Filtered Words; or all Incoming ICQ Info containing any Filtered Words will be displayed 
without any filtering (default option). 

The Words List feature is located in your ICQ program and is applied to Incoming ICQ Info just before the Incoming ICQ Info is 
posted on your screen. Therefore, your Words List feature would not filter your outgoing ICQ events, and except as provided 
herein, it would not filter any other information and content available on or through the Internet. 

Note: This feature provides limited filtration and may not filter any or all of Filtered Words and may not apply to all parts of the ICQ 
event's content and information (e.g. the additional text which may accompany voice messages).

To access your Words List tab:

1. In the Words List tab, click on the Unlock (Enter Protection Password) button to display a Password Verification dialog.

2. Enter your password in the Password field.

3. Click on the OK button to enable the options on the Words List tab.

To create and add a word or URL to your Words List:

1. In the Words List tab, click on the Add button to display the Define New Word dialog. 

2. Enter the word or URL that you want to filter in the Enter Word field. 

3. You may right-click and choose from the Cut, Copy, and Paste options to cut or copy a word or URL from another directory 
and paste it into the Enter Word field. 

4. Click on the OK button to return to the Words List tab. The word or URL now appears on your Words List in the 
Objectionable words window.

5. Click on the Save button to save your changes.

To update your Words List:

1. In the Words List tab, choose from the following options.

· Click on the Edit button to change a word or URL in your Words List.

· Click on the Remove button to remove a word or URL from your Words List.

· Click on the Import List button to import a list of words or URLs from another file or from another user.

· Click on the Export List button to save your Words List in another file or to send to another user.

2. Click on the Save button to save your changes.

To select the filter action for the words or URLs on your Words List and to select to which events you want the action to 
be applied:

1. In the Words List tab, choose from the following filter actions in the Filter Action window.

· Select the Do not filter any events (filter disabled) radio ¤ button to receive all of your Incoming ICQ Info (as defined 
at the beginning of these instructions) with no filtration.

· Select the Replace objectionable words with: radio ¤ button to receive all of your events and view a user's 
information, but filtering out the word or URLs on your Words List with whatever symbol you enter in the corresponding 
field. An asterisk (*) is the default symbol.

· Select the Discard events with objectionable words radio ¤ button to not receive Incoming ICQ Info (as defined at the 
beginning of these instructions) which include any filtered words.

· Check the Replace/Discard only the entire word box to refrain from filtering words that incorporate characters, strings, 
or words that are listed on your Words List.

2. Choose from the following events to which you'd like to apply the filter action you selected.



· Check the Incoming events (messages) box to apply the selected filter action to your incoming events.

· Check the User's information on: Global Directory box to apply the selected filter action to search results pertaining 
to queries you made on the ICQ Global Directory for information about users.

· Check the Chat With A Friend box to apply the selected filter action to the user information available through the Chat 
With A Friend feature.

3. Click Save to save your changes, or click Cancel to exit the dialog without saving your changes.
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Security and Privacy - Password Tab

Configuring the Password Tab

The Password tab enables you to change your password. See the General Tab section to configure your password settings. 

To change your password:

1. Click on the ICQ button and select Security & Privacy to display a pop-up menu of options. Alternatively, select Preferences 
and click Security & Privacy.

2. Click on the Password tab.

3. Type in your new password in the Type Your New Password: field.

4. Retype your password in the Retype New Password field.

5. Click on the Save button to save your settings, or click Cancel to exit the dialog without saving your changes.

Note: It is very important to remember your password! Your ICQ# may not be operable without a password. We recommend 
writing down your password and putting it in a secure place.

If you forget your password, you may try the password retrieval service available on the ICQ Web site at 
http://www.icq.com/password.

Note that the password retrieval service may be of help only in certain cases, and only using an email address or addresses that 
were or are entered in the Email field of the ICQ number User Details. For additional information, please refer to 
http://www.icq.com/password 
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Security and Privacy - Direct Connection Tab

Configuring IP Settings

Some of the communications on ICQ are conducted by Direct Connection (peer to peer). On such communications the IP address 
of any participant is an integral part of the TCP/IP standard protocol of the Internet and therefore may be revealed by the other 
participants of that communication session. In the Direct Connection tab you can set the extent of disclosure of your IP address to 
the entire ICQ community, to users on your Contact List or to a specific communication with an ICQ user. 

To configure your Direct Connection settings:

1. Click on the ICQ button and select Security & Privacy to display the Security dialog.

2. Select the Direct Connection tab.

3. Choose from the following settings.

· Click the Allow Direct Connection with any user radio ¤ button to allow peer to peer communications with the entire 
ICQ community, thus enabling any user to view your IP address.

· Click the Allow Direct Connection with users listed on your Contact List radio ¤ button to allow peer to peer 
communication with users on your Contact List thus enabling them to view your IP address.

· Click the Allow Direct Connection with any user upon your authorization radio ¤ button to allow peer to peer 
communication and enable others to view your IP address upon your authorization.

In any of these settings, you will be able to establish Direct Connection per a specific communication with an ICQ user. 

4. Click on the Save button to save your settings, or click Cancel to exit the dialog without saving your changes.

Please note: This feature is provided to you as a convenience only. ICQ does not guarantee non-exposure of your IP address 
under any of the above settings. The ICQ program is a non-secured application. You should therefore not assume that if you use 
this feature to avoid exposure of your IP address, others would not be able to see it. For more information refer to 
http://www.icq.com/direct connection 

This Help File including Help Cards is provided as a convenience only (*See Welcome to ICQ Version 2000b) and is subject to the 
provisions of the ICQ Terms of Service.

* Access the Main Help File by clicking the ICQ button, selecting Help and then Help Index.

Copyright © 1996-2000 ICQ Inc. All Rights Reserved.



Authorization Mode - Changing

This option allows you to determine whether or not users are required to request your permission to add you to their Contact Lists, 
thus allowing them to detect your availability status modes. You set your Authorization Mode during the ICQ registration process 
and you may change it at any time thereafter.

To determine your Contact List Authorization settings:

1. Click on the ICQ button and select Security & Privacy to display the Security (Ignore/Spam, harassment control) For: 
[User] dialog.

2. Click on the General tab.

3. Choose from the following options under the heading Contact List Authorization:

· Select the All users may add me to their Contact Lists and see my online/offline status radio ¤ button to enable 
any user to add you to his or her Contact List, and therefore see your online status, without requiring your permission.    
Other users will then be able to see your online status.

· Select the My authorization is required before users may add me to their Contact List radio ¤ button to require 
other users to receive your authorization before they add you to their Contact Lists to limit unwanted users from adding 
you to their Contact Lists without your authorization.    In the case that you do not wish to accept an authorization 
request, you may choose not to respond to it and the user will not receive a negative response.

4. Click on the Save button to save your settings, or click on the Cancel button to exit the dialog without saving your changes.

Note:    If you did not originally choose the Authorization Mode but later decided to change to Authorization Mode, you may still 
be listed on the Contact Lists of users who already added you to their lists while you were not yet in Authorization Mode. If such 
a user is bothering or annoying you, you may place the user on your Ignore List.    Another option is to delete your current ICQ#, 
register again as a new user, and then enable the Authorization Mode. This however, will require you to reconstruct your Contact 
List¾see Searching for Users to Add to Your Contact List. 

Note:    A user can send you a message, even if he/she doesn't have you on his or her Contact List, by searching for you in the 
ICQ Directories and using the Send Message option, or sending you a WWPager message from your Personal Communication 
Center, for example. He/she will not, however, know if you are online or offline as long as you did not activate the Web Aware 
option. Please note that during the period your Web Aware option is activated and you are connected to the ICQ servers, your 
Web status indicator on your ICQ Personal Homepage (available in Advanced mode only), when activated, or on your Personal 
Communication Center (available in Advanced mode only), for example, will indicate that you are Online, even if you chose to 
put a user on your Invisible List and therefore, when the Web Aware flag is active other ICQ users and Internet users will be able 
to see your online/offline status from the Web.
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Web Aware - Activating

The Web Aware security feature allows you to determine whether others can see your online/offline status on the World Wide 
Web. When you activate this feature other Internet users will be able to see your online or offline status (from your ICQ Personal 
Homepage when activated, or on your Personal Communication Center, for example). 

To activate the Web Aware feature:

1. Click on the ICQ button and select Security & Privacy to display the Security (Ignore/Spam, harassment control) For: 
[User] dialog 

2. Select the General tab.

3. To allow others to see your presence on the Web, check the Allow other ICQ and Internet users to view my online/offline 
status on the Web box in the Web Aware window.

4. Click on the Save button to save your settings, or click Cancel to exit the dialog without saving your changes.

Please note: During the period your ICQ number's Web Aware feature is activated, and your ICQ software is connected to the 
ICQ servers, the Web status indicators pertaining to your ICQ number will indicate that your ICQ number is in online, even if you 
activated an Invisible (Privacy) mode with respect to certain users. Also please note that even if you chose to activate an 
Invisible (Privacy) mode with respect to certain users, other users may be aware of your ICQ number online status during the 
time your ICQ software is connected to any of the ICQ ActiveLists. (This feature is available in Advanced Mode only).
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Security Level – Selecting

This option allows you to choose from three settings to determine your ICQ program’s security level, regarding when you are 
required to enter your password. If you are the only one with access to your computer, you may select the low security level so 
that you don’t need to enter your password every time you log on to ICQ and in other ICQ operations. Or, you may select the 
medium security level so that you are required to enter your password only for certain ICQ activities. If others have access to your 
computer, you may choose high security level, so that you are required to enter your password every time you log on to ICQ and 
for other activities once ICQ is open.

To determine your security level:

1. Click on the ICQ button and select Security & Privacy to display the Security (Ignore/Spam, harassment control) For: 
[User] dialog.

2. Click on the General tab.

3. Choose from the following options under the heading Security Level.

· Select the Low radio ¤ button to set ICQ to enable ICQ operations (logging in, updating User Details, and changing 
password) to occur without entering your password. This option may be suitable if you're using ICQ on a computer on 
which you are the only one with access.

· Select the Medium radio ¤ button to set ICQ to save your password, and so that most ICQ operations are carried out 
without entering a password. However, changing User Details, changing your password and other settings (e.g. your 
Direct Connection settings) will require the use of your password.

· Select the High radio ¤ button to activate high security level. This is recommended for users who share a computer, yet 
value their security. You will be requested to enter your password every time you run ICQ. Your Contact List cannot be 
accessed until the valid password is given. You will also be required to enter your password to change your user details, 
change your password and for other ICQ activities.

4. Click on the Save button to save your settings, or click Cancel to exit the dialog without saving your changes.

Note: It is very important to remember your password, especially when ICQ is in Medium or High Security Level! Your ICQ# may 
not be operable or not operable at all, without a password. We recommend writing down your password and putting it in a secure 
place.

If you forget your password, you may try the password retrieval service available on the ICQ Web site at 
http://www.icq.com/password.

Note that the password retrieval service may be of help only in certain cases, and only using an email address or addresses that 
were or are entered in the Email field of the ICQ number User Details. For additional information, please refer to 
http://www.icq.com/password 
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Configuring Incoming Events

You may configure incoming events settings for the following additional plugins: ICQ Phone Authorization and Phone Call Request, 
ICQ Picture, ICQ Greeting Card the ICQphone PC to PC Call Request.

Note: Certain options may be available to some and not others. 

Note: To download and install more plugins, go to the Web site. The additional plugins are ICQ ActiveList, IrCQ-Net, Voice Message 
and ICQ Homepage. Once installed, no option to configure the settings for these plugins will be available. You will receive a 
notification upon incoming event by default. If you wish to remove these plugins from your computer, you will need to uninstall them. 
Go to the folder where the plugin is installed (Usually C://Program Files/ICQ/Plugins), click on the file and choose Uninstall. 

Note: This option applies to Advanced Mode only.

To configure your Owner Preferences:

1. Click on the ICQ button in your ICQ Window. 

2. Select Preferences to display the Owner Preferences For: [User] dialog.

3. Select the plugin that you wish to configure.

4. Choose from the following options.

· Select the Set ICQ to display a response dialog radio ¤ button to set ICQ to display a response dialog every time you 
receive an event.

· Select the Set ICQ to automatically accept radio ¤ button to set ICQ to automatically accept incoming events.

· Select the Set ICQ to automatically decline radio ¤ button to set ICQ to automatically decline incoming events.

· Check the Set ICQ to automatically decline incoming event from users that are not on my Contact List box to set 
ICQ to automatically decline incoming events from users that are not on your Contact List.

· Check the Play Sound box to set ICQ to play a sound every time you receive an event.

· Click on the Play  button to hear the sound that will play. Press the 

 button to select another sound from another directory on your hard disk.

5. Click on the Save button to save your changes, or click Cancel to exit the dialog without saving your changes.

To add the plugin if you have removed it:

1. Click on the ICQ button in your ICQ Window. 

2. Select Preferences to display the Owner Preferences For: [User] dialog. 

3. Select the relevant icon.

4. Click on the Add button to import a plugin from another directory on your computer.

Tip: You may need to go offline and then online again in order to activate the change.

To reactivate a disabled ICQ ActiveList Invitation Plugin:

1. Click on the ICQ button in your ICQ Window. 

2. Select Preferences to display the Owner Preferences For: [User] dialog. 

3. Select the relevant icon.

4. Click on the Restore button.

Tip: You may need to go offline and then online again in order to activate the change.

To disable the ICQ ActiveList Invitation Plugin:

1. Click on the ICQ button in your ICQ Window. 

2. Select Preferences to display the Owner Preferences For: [User] dialog. 

3. Select the relevant icon.



4. Click on the Remove button. 

Tip: You may need to go offline and then online again in order to activate the change.

Caution! By downloading, installing, activating or using any software component for ICQ (“ICQ Plugin”) developed or provided by 
third parties, you may be subject to various immediate and long-term risks and may cause extreme damage to your system. To 
review the list of ICQ Plugins developed by ICQ Inc., please refer to the ICQ Plugins Center available at 
http://www.icq.com/plugins.
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